
CCA-101: FUNDAMENTALS OF IT & PROGRAMING 

 

ASSIGNMENT- 1 
 

Q.1 What are the four fundamental parts of computer? Explain it with the help of diagram. 

Ans. The four fundamental parts of computer are: 

1. Input devices 

2. Central processing unit (CPU) 

3. Output device 

4. Memory unit 
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                                Fig: Diagram showing the fundamental parts of computer 



Q.2 Discuss the classification of computer based on size and capacity. 

Ans. The classification based on the size and capacity are as follows: 

➢ Super Computer 

➢ Main frame computer 

➢ Mini computer 

➢ Micro computer 

 

Super computers: super computer are the most powerful and physically the largest by size. 

These are system design to process huge amounts of data and the fastest supercomputers can perform 

over one trillion calculations in a second. Supper computer have thousands of processors. Because of their 

extra extraordinary speeds, accuracy and processing power, supercomputer is well suited for solving 

highly complex problems and performing tasks that demand huge amounts of calculations. 

Mainframe computer: Mainframe computers are very large often filling an entire room and can process 

a thousands of million of instructions per second. In a mainframe environment, user connect to the 

mainframe through the many terminals wired to the mainframe. Mainframe are capable of supporting 

hundreds to thousands of users simultaneously. Some of the functions perform by a mainframe include: 

flight scheduling, reservations and ticketing for an airline etc. 

Minicomputers: Minicomputers are much smaller than mainframes. These computers are less expensive. 

Sometime refer to as Midrange Server or Midrange Computer, they are typically larger, powerful and 

more expensive than desktop computers. Midrange computer are usually used by small and medium- 

sized businesses as their servers. Users connect to a server through a network by using a desktop 

computer. 

Microcomputers: Microcomputer are the most frequent used type of computer. Also, know as personal 

computer (PC), a microcomputer is a small computer system design to used by one person at a time. 

 

Q.3 What is the meaning of computer generation? How many computer generation are defined? What 

technology were/ are used? 

Ans. Generation in computer terminology is a change in technology of a computer which were being used. 

      There are four computer generation such as 1st generation 2nd generation 3rd generation, and 4th 

generation. 

In the first computer system, Vacuum tubes were used. 

Transistors are used in the second generation. 

Integrated circuit were used in the third generation. 

In the fourth-generation microprocessors are used. 

 



Q.4 Differentiate between Volatile and non-Volatile memories? 

Ans.                   Volatile memory non-volatile memory 

1. It is a computer storage that only                                                          

Maintains its data while the device is  

  Powered.  

2.  E.g., RAM 

3.  Primary storage has limited storage  

Capacity and is volatile 

 

 

 

 

Q.5 Distinguish among system software, application software and open-source software on the basis of 

their features. 

Ans. System software: IT is type of software that design to run a computer’s hardware and application 

programs. Software like operating systems, compilers, editors and drivers etc. come under this category. 

A computer cannot function without the presence of system software.  

Application software: it is a software created for specific used by end users. It can be called an application 

or simply an app. 

        Example: word processors, accounting app etc. 

Open source software: it is a type of computer software in which source code is release under a license 

in which the copyright holders grant user rights to study, change and distribute the software to anyone 

and for any purposes. 

        Example-le: the Linux operating system. 

 

Q.6 a) Create a file in MS word to insert a paragraph about yourself and save it with file name “yourself”. 

Describe all step involve in it. 

        b) Write steps regarding followings 

➢ To change the fonts style  

➢ To change the font size  

➢ To change the font color 

➢ To highlight in yellow the line that reads “need to get IMS’s address”. 

 

a) Ans. “yourself” My name is Nh Fhaomei. I am 21 years old. I love to sing and play. I am a student of arts 

at D.M college, IMPHAL, Manipur. Currently I am learning CCA course at RGI TRAINING INSTITUTION. 

1. It is a type of computers memory that 

has the capability to hold saved data 

even if the power is turn off. 

2. E.g. ROM, hard disk, floppy disk, etc. 

3. Secondary memory provides 

permanent storage of data and in bulk 

quantity. 

 



 

The steps involved are: 

1. We click the Microsoft office button. 

2. We select new. The new document dialogue box appears. 

3. We select blank document under the blank and recent section. It will be highlighted by default. 

4. We click create. A new blank document appears in the word window. 

5. To save the save document, we click again the Microsoft office button. 

6. WE select save as      word document. The save as dialogue box appear. 

7. We select the location where we want to save the document using the drop-down menu. 

8. We enter the file name “yourself” for the document. 

9. We click the save button. 

 

 

b) Ans: Steps to change the font style: 

1. We select the text we want to modify. 

2. Left click the drop-down arrow next to the font style box on the home tab. The font style drop-

down menu appears. 

3. We move cursor over the various font style. A live preview of the font will appear in the document. 

4. Left click the font style we wane to use. The font style will change in the document. 

Steps to change font size: 

1. We select the text we want to modify. 

2. Left click the drop-down arrow next to the font size box on the home tab. The font drop-down                    

button appears. 

3. We move cursor over the various font sizes. A live preview of the font size will appear on the 

document. 

4. Left click on the font size we want to used. The font size will change in the document. 

 

Steps to change the font color 

 

1. We select the text we want to modify. 

2. Left click the drop-down button arrow next to the font color box to the home tab. The font 

color menu appears. 

3. We move cursor on various font colors. A live preview of the color will appear in the 

document. 

4. Left click the font color we want to used. The font color will change in the document. 

 

Steps to highlight the line: 

1. We select the lines that reads “needs to get IMS’s address” 

2. We click the highlight command and select yellow color in the font group on the home 

tab.  



 

Q.7. Create a file in MS-Words for the following document and save it with file name ‘ms-word’. 

Describe all steps involved in it.  

Ans: MS Word 

Ms word is a widely used commercial word processor develop by Microsoft.  

MS word is application software, which is capable of  

• Creating  

• Editing 

• Saving, and 

• Printing any type of document 

 

The steps involved are: 

1. We click the Microsoft button. 

2. We select new. The new document dialog box appears. 

3. We select blank document under the blank and recent section. It will be highlighted by default. 

4. We click create. A new document appears in the word document. 

5. We create the given document from the questions. 

6. We select the text “MS Word” and change the font size by clicking on the font size box on the 

home tab. 

7. We select the text MS word” to change the font the color into red by clicking on the font color 

menu. 

8. We select the text word processor and underline it by clicking the underline command in the font 

group the home tab. 

9. We select the text “MS word” to change the font style into italic by clicking the italic command. 

10. We select the text we want to format as a list and click on the bullets command on the home tab. 

11. We change the font color on the text “creating” and “saving” into black and red resp. by clicking 

on the font color command, again we select the text “and” and cli9ck on strikethrough command. 

12. We save the file name as “ms-word” by clicking the Microsoft office button and select save as. 

13. We select the location where we want to save the document using drop-down menu. 

14. We click the save button. 

 

Q.8 Create a file in MS-word for the following document and save it with the file name “equation”. 

Describe all step involved in it. 

Equations 

X2 + y5 =30 

Z3+ Q4=50 

A2+ B8=X2+ Y8 



Ans:  Equations 

X2 + y5 =30 

Z3+ Q4=50 

A2+ B8=X2+ Y8 

The steps are:  

1. We create the given document in MS-word 

2. We select the text where we want to format and click on the subscript and superscript 

command on the home tab 

3. We save the file name as “equations” by clicking the Microsoft office button and select save 

as  

4. We select the location where we want to save the document using the drop-down menu 

5. We click the save button 

 

Q.9. Create a file in MS-word that converted existing highlight text to table as shown below and save 

it as file name ‘text_to_table’. Describe all step involved in it. 

      Select the text you want to convert 

      Select the Insert tab. 

      Click on table command. A dialog box appears. 

      Click on Convert Text to Table, a new dialog box appears 

      Here set number of columns. 

      Click on OK Finally Select text convert in a table 

   

       

  

Ans. To convert existing text to a table: 

1. We select the existing highlight text that we want to convert. 

2. We select the insert tab 

3. We click the table command  

4. We select convert text to table from the menu. A dialog box appears 

5. We click ok. Then the text appears in a table. 

 

 

 

 

Select the text you want to convert. Select the insert tab. 

Click on Table command. A dialog box appears.  Click on Convert Text to Table, a new dialog box 
appears 

Here set number of columns. Click on OK Finally Selected text convert in a table 



Q.10. Create a file in MS-word to insert a table in the document. Describe all step involved in it. 

Ans.  

          

          

          

          

          

          

          

   The steps are: 

1. We place our insertion point in the document where we want our table to appear 

2. We select the insert tab 

3. We click the table command 

4. We drag our mouse over the diagram square to sect the numbers of columns and rows im 

the table.  

5. Left click our mouse and the table appears in the document. 

6. We enter the text into the table  

 

Q.11. Create a following worksheet in MS-excel and save it with name ‘book1’. 
 
 
Ans. 
 

Roll No. Name Marks

1 n1 60

2 n2 70

3 n3 80

4 n4 90

5 n5 40

6 n6 50

7 n7 77

8 n8 44

9 n9 88

10 n10 55  
 

Q.12. Calculate the following things of a range (C2:C11) of the data in the worksheet created in Question 

no. 10. 

➢ The sum of mark using AutoSum in a range of cells (C2:C11) 

➢ Average of the mark in a range of cells (C2:C11) 

➢ Highest marks in a range cell (C2:C11) 

➢ Minimum marks in a range of cells (C@:C11) 



Ans. 

       

NO. Name Marks Sum Average Maximum Minimum

1 n1 60 654 65.4 90 40

2 n2 70

3 n3 80

4 n4 90

5 n5 40

6 n6 50

7 n7 77

8 n8 44

9 n9 88

10 n10 55  

 

Q.13. a) Describe the various step involved in the following 

➢ To modify column width of a worksheet 

➢ To modify a row height of a worksheet  

➢ To delete rows and column of a worksheet 

           b) Describe the following term in the worksheet 

➢ Absolute reference and relative reference in the worksheet 

➢ Cell address 

Ans. (a) 

➢ To modify column width of the worksheet: 

I. Select a column or a range of columns. 

II. Select a home tab and in the cells group, select Format. 

III. Click on column width and type the width for column. 

IV. Select OK. 

➢ To modify the row height of a worksheet. 

I. Select a row or range of a rows. 

II. Select a Home tab and in the cells group, select Format. 

III. Click on Row Height and type the height for row.  

IV. Select OK 

 

➢ To delete rows and columns of a worksheet. 

I. Select the cell you want to delete within the column or row. 

II. Select Home tab. And in cells group click on Delete Sheet Column or Row. 

OR 

                               Select the desire row or column. 

 

 



(b) Ans.  

➢ Absolute reference: 

An absolute reference in Excel means there is a fix point of reference applied to a cell or a formula. 

This is so the return value will always stay the same no matter where the cell or formula moves 

to – within the same sheet or across different sheet. 

This refer to a fixed point of reference is a constant, and involved the use of dollar sign $ in the 

formula (i.e., everyone is to received the same bonus payout, so the amount $1500 is constant in 

this situation).  

 

➢ Relative reference: 

It is a default cell reference in excel. It is simply the combination of column name and row number 

without any dollar ($) sign. When you copy the formula from one cell to another the relative cell 

address changes depending on the relative position of column and row. C1, D2, E4 etc. are 

example of relative cell references. Relative reference are used when we want to perform a similar 

operation on multiple cells and the formula must change according to the relative address of 

column and row. 

This refers to a relative point of reference, is constantly changing and dollar sign ($) is absent in 

the formulae (i.e., when each unit price and quantity are different variables, there’s no constant 

in the calculation). 

➢ Cell address: 

A cell address is a combination of column letter and a row number that identifies a cell on a 

worksheet. 

For example, A1 refers to the cell at the intersection of column A and row 1; B2 refers to the 

second cell in column b, and so on. 

         When used in formula, cell references help Excel find the values the formula should calculate. 

For instance, 

➢ To pull the value of A1 to another cell, you use this simple formula: 

=A1 

➢ To add up the values in the cells A1 and A2, you used this one:  

=A1+A2 

 

Q.14. a) What tools are available to customize our PowerPoint presentation? 

           b) Write the steps for the following action for the creation of power point presentation 

➢ Open a blank presentation 

➢ Save the presentation as Lab1.pptx 

➢ Add a title to the first side: the name of your college  

➢ Type your first name and last name in the Subtitle section  

➢ Add a new slide which has a Title and Content 

 

 



Ans. (a)  

         Tools available to customize our PowerPoint presentation are: 

a) Perspector 

b) Pivot Viewer 

c) Autodesk 3DS Max 

d) Visual Bee PowerPoint Add-in 

e) SmartArt 

f) Animations and Transition 

g) Wordle 

h) CA coo 

i) Oomfo 

j) Clip champ 

(b) ans.  

➢ To open blank presentation: 

I. Open PowerPoint presentation using ‘Run’ command (window key +R). 

II. Select the ‘blank Presentation’. It is open. 

➢ Save the presentation as Lab1.pptx.: 

I. Select the ‘File’ on tab bar. 

II. Click on ‘Save as’ option. 

III. Click on document/Desktop as your choice. 

IV. Type the name ‘Lab1.pptx’. 

V. Click the ‘Save’ button. 

➢ Add a title to the first slide: the name of your college. 

I. Left click on the ‘Click to Add Title’ section on the first slide. 

II. Type the name of your college. 

➢ Type your first name and last name in the subtitle section: 

I. Left click on the ‘Click to Add Subtitle’ section. 

II. Tyle your first name and last name. 

➢ Add a New slide which has a Title and content. 

I. Select the home tab. 

II. Click on the dropdown button of the ‘New Slide’ on toolbar. 

III. Select the slide having ‘Title and Content’. It is added. 

 

Q.15. Write the steps for creation of a set of PowerPoint slide that demonstrates your skill to use the tools 

of PowerPoint. It should include the following things   

➢ Title slide & bullet list 

➢ Inserting Excel Sheet 

➢ Clip art and Text 

➢ Slide show effects 

Ans.  



➢ Title slide and bullet list: 

I. Open PowerPoint Presentation. 

II. Select the Home Tab 

III. Click the dropdown button on ‘New Slide’ at toolbar. 

IV. Select the slide having title slide and bullet list. 

➢ Insert Excel sheet: 

I. Open the slide where you want to insert the Excel Sheet. 

II. Select the ‘Insert tab’. And click om ‘Object’ on tool bar. 

III. Select the ‘Microsoft Excel Worksheet’ object type. 

IV. Click the ‘OK’ button. 

➢ ClipArt and Text: 

I. Select the Insert Tab. 

II. Select the ‘Pictures’ or ‘Online pictures’ on tool bar. 

III. Choose the appropriate art for the topic. 

IV. Click on the ‘Insert’ button. 

➢ Slide show effects: 

I. Select ‘Design Tab’ for themes, Variant and slide size. 

II. Select ‘Transition Tab’ for cut, fade, push, wipe, split, reveal, shape, flash, etc. for slide 

effects. 

 

Part-2  

 

Q.16. What is the difference between Machine Language and High-Level Language? 

Ans.  

Machine language High level language 

1. A computer programming language 
consisting of binary instructions which a 
computer can respond to directly 

2. It required no translator to translate the 
code. It is directly understood by the 
computer 

3. This language makes fast and efficient 
use of the computer. 

1. It is a programming language that 
enables development of a program in 
a much more user-friendly 
programming context 

2. It takes additional translation time to 
translate the source code to the 
machine  

3. They are programmer friendly. 

 

 

Q.17. Discuss about different data types of C programming language. 

Ans. The different type of data C programming language are: 

Char: the most basic data type in C. it stored a single character and requires a single bite of memory in 

almost all compilers.  



Int: as the name suggest, an int variable is used to store an integer. 

Float: it is used to stored decimal numbers 

Double: it is used to stored decimal numbers (number with floating point value but its range of value is 

high in comparison to float) 

Q.18. Find the output of the following expressions 

a) X=20/5*2+30-5              b) Y=30-(40/10+6) +10             c) Z=40*2/10-2+10 

Ans. A) X=33 

        B) Y=30 

        C) C=16 

Q.19. Describe the syntax of the following statements 

              (a) if – else statement      (b) for loop       (c) while loop      (d) do-while loop 

Ans. a) if-else statement 

              If statement can be followed by an optional else blocked of statements, which execute when the 

Bootcan expression is false. 

Syntax 

If (expression) 

{ 

True block of statements; 

} 

Else 

{ 

Else block of statements; 

}  

 

b) For loop in similar to while loop. Basic syntax of loop is as follows: 

 

For (expression 1; expression 2; expression 3) 

{ 

Block of statement 

} 

In the above syntax  

  Expression 1 -initializes variables. 

  Expression 2-condition expression as long as this condition is true, loop will keep 

Executing. 

   Expression3 -it is the modifier which will increase or decrease the value of the variable. 

 

c) While loop. 

Basic syntax of while loop is as follows 

   While (condition) 



               Single statement. 

OR while (condition)  

     { 

     Block of statements 

     } 

d) Do-while loop. 

       Do-while loop is just like a while loop except that the text condition is checked at the end of the 

loop rather than the start. This has the effect that the body of the loop are always executed at least 

once 

Basic syntax of Do-while loop is as follows 

Do 

{ 

Single statement   

     Or 

Block of statements 

} while (condition); 

 

Q.20. Find the output of the following segments 

 

a) b) c) 

#include <stdio.h> 
Int main() 
{  
 Int i; 
   for (i=1, i<2; i++) 
   { 
      Printf(“IMS Ghaziabad\n”); 
     } 
} 

#include <stdio.h> 
Int main() 
{  
 Int I = 1; 
 while ( i <=2 ) 
   { 
      Printf(“IMS Ghaziabad\n”); 
      I = i+1; 
     } 
} 

#include <stdio.h> 
Void main() 
{ 
   Int a = 10, b = 100 
     If (a>b) 
     printf( “Largest number is %d\n”,a); 
   else 
      printf( “Largest number is %d\n”,b); 
}  

 

Ans. A) 1 

         B) 2 

         C) b=100 

 

 

 

 


